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一、前言 

隨著深海探勘的進展，高解析度的精準海床調查已成為海洋研究突破

的關鍵，對於特定調查標的之掌握，更是成功與否的關鍵。例如對於深海

生態系的研究，或是海床油氣與天然氣水合物異常特徵的採樣，精準海床

調查便是相當重要。若以海底冷泉系統說明，海床冷泉口所噴發的物質是

提供周圍特殊的生物群集養分，因此是否能清楚掌握冷泉系統的噴口位置

並進行取樣，便能左右最終的成果解釋。而傳統的船載式儀器無法辨識出

海床中細微特徵，若能有精準的水下定位技術，搭配水下載具進行高解析

度的水深與光學影像調查，便能清楚地將冷泉噴口的各種細部特徵予以掌

握，之後再進一步進行準確的岩心或生物標本取樣，如此對於冷泉系統的

研究便能有所突破。因此，在高解析度的精準海床探測的發展上，水下定

位技術與水下無人載具的應用便是世界各國主要發展的重點。本手冊介紹

高解析度海床資料的重要性，水下定位之原理與實務校正經驗，並藉由對

深海底拖式攝影系統、準確岩心採集與自主式水下無人載具在我國研究船

上實作的經驗，來說明臺灣研究船如何搭配應用水下定位技術進行高解析

度的精準海床調查的海洋科學研究。 
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二、USBL 系統簡介： 

水下定位是一種利用水下聲波幾何原理的水聲學進行定位的系統，方法大

致可分成有長基線(long baseline, LBL)、短基線(short baseline, SBL)及超短基線

( ultra short baseline, USBL)三種。LBL 的定位法主要是在水下放置三個以上的

固定定位站，並透過定位站與作業點之間的訊號傳遞時間差，利用三點定位法

作業點的精確位置。此方法的定位站與作業點之間的距離較長（故稱長基線），

可達數公里，其定位效果最佳，但較為費工費時。SBL 則是將三個已知定位站

點設定為船首、船尾左舷、船尾右舷三點間，也是利用三點定位法之交叉點進

行定位，但定位站與作業點之間的距離則縮短為數十公尺。而 USBL 顧名思義

就是將三已知點設定在更小的數公分範圍內，也是目前進行海洋探測時的主流

方式，其發展始自 80 年代，現已廣泛運用於各種精準海床調查定位技術中。 

USBL 的原理是透過測量信號的到達方位和距離，並藉由計算作業定位點

與接收基站陣列間的訊號走時與相位差來獲得水下定位結果。其優點是系統及

運作費用較低，操作也較其他兩種定位法簡便容易，但其定位元精度需高度仰

賴研究母船上的其他設備，如電羅經、姿態感測器和深度感測器等，將各種資

訊精確整合後，其定位精準度方能應用在高解析度的精準海床調查中。 

目前水下定位系統經常應用於海底地形勘探、水下航行載具的控制和水下

遙控作業等應用領域。同時隨著海洋開發事業和科學技術的發展，利用水聲定

位實現水下目標的跟蹤、定位，海上石油探勘， 海底管道和光纜、電纜的鋪設

定位及故障維修，潛航器的水下導航、水下結構施工和定位等領域。 
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圖 1. USBL System (baseline issue12) 
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三、USBL 系統架構： 

本技術手冊主要以 Sonardyne USBL Range System 來做說明，超短基

線（USBL），有時也被稱為超級短基線（SSBL）。一個 USBL 系統中除了主

要發信號的音鼓(Transceiver)，還包括多個其它組件，其包括船體運動姿

態儀( Vertical Reference Unit，VRU)和電羅經，提供準確的俯仰，滾轉和航

向用於校準的目的，精確的衛星定位系統(GPS)及 USBL 的控制及運算電腦

系統。(如：圖 2. USBL 系統架構) 

 

 

圖 2. USBL 系統架構 

 

水下定位系統運算音鼓(Transceiver)收發到目標的聲信號來檢測距離

和方位，距離是以音鼓(Transceiver)與目標間聲信號行進的速度(聲波)時間

來計算，而方位的計算則是音鼓(Transceiver)接收信號時的相位差及算出

到達信號的角度。(如圖 3. USBL 聲訊號傳遞示意圖圖 3. USBL 聲訊號傳遞示

意圖 )， 

Sonardyne USBL Range System 的優點是運用其獨特寬帶調頻技術，讓

定位系統在水深 10 公尺到數千公尺深運作，都無須變更任何組件，能快速
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得到精確的目標範圍，同時還保持距離分辨率。 

 

 

 
圖 3. USBL 聲訊號傳遞示意圖 

 

 

圖 4. Sonardyne USBL System  
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四、USBL 硬體安裝： 

下面圖 5 列出 Sonardyne USBL Systen圖 5. Sonardyne USBL 系統儀器

儀器清單，作業規劃上需要將所有儀器清點打包，並聯絡貨車載運事宜。

音鼓(Transceiver)的伸縮固定架在載運前請先試用油壓開闔是否順暢，若不

順暢要先除鏽並加油潤滑。船泊作業碼頭的時間要與船務室人員確認，還

需要兩台吊車利用白天執行吊掛音鼓(Transceiver)的伸縮固定架作業。下面

將一一說明儀器各部件安裝細節。 

 

圖 5. Sonardyne USBL 系統儀器 

 

4.1 音鼓(Transceiver)安裝 

音鼓(Transceiver)的安裝首先將電纜與音鼓端接頭連接妥當(如圖 6)，

並將電纜由伸縮固定架的中孔穿過拉出，用繩子綁好剩下的纜線固定在伸

縮架側邊，再將 USBL 音鼓(Transceiver)對準伸縮固定架的船艏方向螺絲孔

位，用螺絲以對角順序上鎖並平均鎖緊； 
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完成後由兩台吊車協力配合將伸縮固定架豎起，(如圖 10) ，一人用無

線電控制指揮動作，吊高移到至船上的月池處。安裝音鼓(Transceiver)至伸

縮固定架時須注意方向，(如圖 9)有清楚的貼紙標明船艏方向，若安裝音鼓

(Transceiver)角度錯誤會導致目標物方位計算錯誤。協力調整伸縮固定架的

位置並將其四腳與月池處四角柱用螺絲鎖好固定後，將電纜沿著周邊環境

佈線至 USBL 主機處。 

 

圖 6. USBL GDT Transceiver Cable 
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圖 7. USBL 音鼓(Transceiver) 

 

 
圖 8.音鼓(Transceiver)伸縮固定桿及設計圖 
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圖 9. 音鼓(Transceiver)安裝 

 

 

圖 10. 45 噸吊車將音鼓(Transceiver)固定架吊至海研一號月池 
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圖 11. 音鼓(Transceiver)固定架安裝完成 

 

圖 12. 音鼓(Transceiver)固定架

的油壓泵及控制閥 

 

音鼓的伸縮固定架可伸縮約 2 公尺(如圖 8)。當開始定位作業時，要先

操作油壓泵控制閥將伸縮固定架伸出，讓音鼓(Transceiver)伸出超過船底，

如此聲波訊號的傳遞才不會受到船體遮蔽影響；當船隻未作業航行時，一

定要收回音鼓的伸縮固定架，避免船隻高速行駛下讓音鼓或船體受損。 

操作油壓系統讓固定架伸縮時要注意油壓管路及音鼓的電纜會跟著伸縮

一同受到影響，所以安裝時要先預留線路的可動長度及將不動的部分另外

固定。 

 

4.2Vertical Reference Unit (VRU)安裝 

VRU 提供了 roll (rotation about surge axis)、pitch (rotation about 

sway axis)、 yaw (rotation about heave axis)等資料，讓 USBL 計算目標方

位及距離時修正訊號傳遞因船體的運動的誤差量。 

當 USBL 系統的 Tranceiver 伸縮固定架安裝完成後，將 VRU 的固定底

板用螺絲鎖在伸縮固定桿的上方側邊，再將 VRU 固定在底板上，(如圖 15 灰
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色的 VRU 底板)，拿取 VRU 主體時要小心，要避免大力搖晃及碰撞，不然

內部感測器會受到損傷；VRU 也是有方向性，所以安裝時需要注意主體機

身上的標示，上方箭頭處對準船艏方，最後再將 VRU 的電纜接頭連接並佈

線至 USBL 主機位置。 

 

圖 13. VRU 主體及電纜 

  

圖 14. VRU 的電源供應器及資料傳輸線 
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圖 15.  VRU 的安裝位置 

 

4.3 USBL Navigation Controller Unit(NCU)的主機安裝 

Sonardyne USBL System 系統主機及控制電腦安裝在一個可拖行的儀

器箱中(圖 16)，打開前後蓋，拿出訊號線及電源線，接上 NCU 後面板上

對應的接頭。NCU Slot 1 與控制電腦的 RS232 port 連接，NCU Slot 2 PortA 

連接音鼓(Transceiver)電纜，NCU Slot 6 PortA 連接 GPS 訊號線，NCU Slot 

6 PortB 連接 GYRO 訊號線，NCU Slot 7 PortA 連接 VRU 訊號線，NCU 詳

細各埠連接定義(圖 20)。 

連線完成後將螢幕拉出翻起，開啟主電源即可操作 USBL 系統的軟

體，目前系統安裝有 Range 、Fusion 兩套軟體，需要配合軟體鎖

KeyPro(圖 17)才能使用全功能，請將黃色的 Key 插在這台電腦上任一個

USB Port 皆可，要小心保管避免遺失。 
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圖 16. USBL 主機及控制電腦 

 

 

圖 17. Sonardyne USBL Software KeyPro 
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圖 18. NCU 前面板 

 

 

圖 19. NCU 後面板 
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圖 20. NCU Slot 列表 
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圖 21. NCU 與 PC 的資料傳輸線 

 

4.4 GPS & GYRO 的硬體安裝 

這套 USBL 系統可接受 NMEA0183 格式的 GPS & GYRO 資料，因此研

究船上的 GPS 系統大多都可以支援。而儀器的通訊協定都可以在 Range 或 

Fusion 兩套操作軟體內設定，(圖 22. GPS & GYRO Cable，圖 23. GPS & GYRO 

資料傳輸線接線圖)。 

USBL 系統上全球衛星定位儀(GPS)最好是具備差分定位的精度，海研

一號上使用 OminStar 8200HP DGPS，可全天候接收衛星修正值得到 DGPS 船

位，在 XP mode 下定位誤差小於 0.20m；此外還需量出 GPS 接收天線與音

鼓(Transceiver)相對位置距離，這些數值之後要輸入 Ranger System 軟體相

應的欄位內，詳細設定後面章節說明之。 

每艘船隻都有各自的 GYRO 系統提供航行控制，海研一號上則還另配

備一台科學探測作業專用 IXBLUE Quadrans IMO grade surface 

gyrocompass & attitude reference system，提供高精度的船艏向及船體

運動資料。 
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圖 22. GPS & GYRO Cable 

 

 

圖 23. GPS & GYRO 資料傳輸線接線圖 
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4.5 Wideband Sub-Mini Transponder/Responder (WSM)安裝 

WSM 是一個水下寬頻應答器(圖 24. WSM 規格)，可固定在目標物上下

水，當它接收到船上的音鼓(Transceiver)發射聲波時，也會傳遞聲波回復，

經過運算可知目標物的距離及方位。 

 

圖 24. WSM 規格 

 

WSM 內部使用 24Vdc 長效 Ni-MH 電池，使用前先確認以免電力不足

無法運作。使用三用電表量測 WSM 接腳 Pin 2&3 電壓(圖 27. WSM 接腳定

義)，若電壓 < 20Vdc 表示內部電池需要再充電；充電時先將 WSM 開關轉

到 OFF 處，然後接上 WSM 的專用充電器到資料傳輸線開始充電(圖 26. WSM

充電連線)，充電時 WSM 不可同時做資料傳輸及設定，剛開始充電的 10 分

鐘，資料傳輸線上的燈號顯示(圖 25. WSM 充電狀態表)，可知充電的狀態，

電力是否飽足，WSM 完成充電約需 4~6 小時。 

 



24 
 

充電狀態 

 

Partially discharged 紅&黃燈閃爍 2~3 分鐘後，紅燈恆亮進入快速充電模式,

約 6 小時充飽電 

Fully charged 黃燈亮數秒後，紅&黃燈閃爍 6 分鐘，黃燈恆亮 

Fully discharged 紅&黃燈閃爍 6 分鐘，黃燈恆亮。拔掉充電器及線靜待

5 分鐘，之後重新接上充電器若紅燈亮起則進入放電模

式 

Deeply discharged 紅&黃燈閃爍 6 分鐘，黃燈恆亮。充電 20 分鐘再拔掉

充電器及線靜待 5 分鐘，之後重新接上充電器若紅燈亮

起則進入紅&黃燈閃爍 2~3 分鐘後，紅燈恆亮進入快速

充電模式,約 6 小時充飽電 

Full charge 紅燈滅，黃燈恆亮 

圖 25. WSM 充電狀態表 
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圖 26. WSM 充電連線 

 

 

 

圖 27. WSM 接腳定義 
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圖 28. WSM 接頭及開關 

 

當 WSM 的 VENT 若有突起時(圖 28. WSM 接頭及開關)，表示機體內部

有較大的壓力，有可能是水浸入機體，電池產生化學變化，使用前後要小

心檢查確認 VENT，避免壓力過大爆裂受傷。 

設定 WSM 必須與電腦連接(圖 29. WSM 連接電腦)，執行 WSM 

terminal 軟體，進入後首先選擇 Setup -> Serial Port Setting，設定

WSM 與電腦連接的 Serial Port 通訊協定等，設定完成後按 OK(圖 30. WSM 

Terminal 設定畫面的圖 A)，然後回主畫面上選擇 Get Status(圖 30. WSM 

Terminal 設定畫面的圖 B)，等待電腦取得 WSM 的狀態資訊，WSM Terminal

上會出現很多資訊時，就表示兩者溝通成功，若主畫面沒有出現 WSM 狀態

資訊，表示溝通失敗，查看一下電腦系統的裝置管理員中 Serial Port 設定

是否正確。WSM Terminal 主畫面上還會顯示每個 WSM 使用的頻率編碼設定
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(圖 31. WSM General Settings 設定畫面的圖 A)，若要變更可按 Quickset 

Wideband 進入 General settings 畫面下重新設定(圖 31. WSM General 

Settings 設定畫面的圖 B)，變更後記得將設定的頻率編碼用麥克筆明顯標示

在外殼處。 

 

 

圖 29. WSM 連接電腦 

 

 

圖 30. WSM Terminal 設定畫面 
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圖 31. WSM General Settings 設定畫面 

 

測試 WSM 發射是否會正常發射訊號，選擇 Diagnostic 裡的

Respondder Trigger(圖 32. WSM Ping test 畫面的圖 A)，Ping Test 畫面下

選擇 Start(圖 32. WSM Ping test 畫面的圖 B)，若耳朵靠近 WSM 音鼓面可以

聽到高頻的聲響，表示運作正常，記得要選擇 Stop 結束訊號發射，Back 回

到主畫面。 

WSM 下水使用一定要記得將防水接頭確實接上，開關轉到 ON 處，完

成充電後的電壓要在 20Vdc 以上(圖 30. WSM Terminal 設定畫面的圖 C)。 
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圖 32. WSM Ping test 畫面 

 

4.5 Dynamic Position Transponder (DPT)安裝 

DPT 水下應答器專為海床設計部署或大目標物的跟踪使用，特別配備

了堅固耐用的彈簧輔助釋放機構，它的全向性波束角度可達±130∘，還可

利用軟體設定發射接收的功率大小，但 DPT 內部使用長效電池無法再充

電，施放時要注意查看電池的電量及有效期限。 

DPT 與電腦間可透過專用的資料傳輸線溝通，連接的方式(圖 35. DPT

與電腦連接設定)，連接到電腦端得接頭有兩個，分別標示 CPU 及 DAS，其

中 DAS 接頭是在校正 DPT 內部感測器時專用，而其他 DPT 設定時則使用

CPU 接頭。 

將 DPT 開關轉到 ON，執行 Test Terminal 軟體，進入主畫

面下先進入 Comm Port Selection 選擇 Port(圖 36. DPT Termnal Setting 畫面的

圖 A)，再按 General Status 擷取 DPT 的設定及狀態，若等待幾秒畫面上沒

有出現 DPT 的資訊，請查看一下電腦系統的裝置管理員中 Serial Port 設定
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是否正確。下水之前一定要查看左邊 Function Level 欄位是 3d(如圖 36. 

DPT Termnal Setting 畫面的圖 B)，查看電池電量、設定傳輸的頻率及功

率…等等。 

按下 Hardware Self Test 會測試 DPT 內部電路版的狀態，按下 Read 

Sensor 則將內部感測器(壓力、溫度)的資訊顯示在視窗左邊(如圖 37. DPT 

Terminal 畫面)，按下 Release Test 後，DPT 的 Release 馬達開始轉動 180

∘打開，在按一次則轉動 180∘關閉，(如圖 38. DPT釋放元件的構造)此時

可聽到明顯的機械運作聲音，可將 SHACKLES 扣上完成釋放機制安裝(如圖 

33. Sonardyne 8124 DPT 右下圖)。 

 

 

圖 33. Sonardyne 8124 DPT 
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圖 34. DPT 規格 

 

 

圖 35. DPT 與電腦連接設定 
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圖 36. DPT Termnal Setting 畫面 

 

圖 37. DPT Terminal 畫面 
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圖 38. DPT 釋放元件的構造 

 

拆 DPT 更換電池包，原廠有附專用的拆殼工具(如錯誤! 找不到參照

來源。)拆開機殼，工具記得收放在 DPT 箱內，不要遺失。 

 

電池包更換步驟如下， 

I. 首先將 DPT 放置在乾淨的桌面或地面固定好，找出專用工具放在一

旁。 

II. 將 DPT 開關轉到 OFF。 

III. 人員站 DPT 側面不可站在音鼓的正前方，以免拆蓋時內外壓力差爆開

受傷。 

IV. 如圖 40. 使用六角板手卸下螺絲錯誤! 找不到參照來源。圖 41. DPT 

開蓋步驟 1，開啟時若聽到嘶嘶聲，表示內部壓力大，先暫停不要動，

讓內外壓力平衡，沒有聲音後再繼續拆蓋。 
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V. 如圖 42. 小心移開上蓋及接線 

VI. 圖 43. 卸掉內蓋固定螺絲。 

VII. 如圖 44. 取出電池包更換。 

VIII. 電池包更新後，鎖回內蓋，接上各接頭並理順接線。 

IX. 鎖回上蓋前要檢查 O-Ring 是不是要更換，當發現有材質老化、斷裂或

不平整變形時一定要換掉。 

X. 使用無塵紙清潔機殼及 O-Ring 接觸的地方，塗上凡士林潤滑，將上蓋

對準後用力闔上，並將螺絲鎖緊固定。 

 

圖 39. DPT 拆機殼專用工具 
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圖 40. 使用六角板手卸下螺絲 

 

圖 41. DPT 開蓋步驟 1 
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圖 42. 小心移開上蓋及接線 

 

圖 43. 卸掉內蓋固定螺絲 
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圖 44. 取出電池包更換 
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五、Range 軟體設定： 

控制電腦中有兩套操作軟體，其中 Range 軟體在介面及操作上較為簡

單，而 Fusion 軟體則是偏向工程應用的功能更多，但是相對需要輸入的設

定及操作介面上也更為複雜，因此下面將介紹 Sonardyne USBLSystem 的

Range 軟體操作步驟及設定為主。 

完成 USBL 所有硬體設備的安裝後，在開啟 NCU 及 PC 電源前，再次確

認系統所有的輸出入資料傳輸線、電纜等都連接到相對應的埠位；開啟電

源進入 Windows 系統下，記得要將黃色的 USBL Dongle 插在 PC 的任一

USB Port，點選桌面上 進入 Ranger 軟體主畫面(如圖 45)，圖中

箭頭處會顯示已設定的音鼓(Tranceiver 及 Transponder)，按一下，音鼓就

擊發開始定位工作，左側欄位顯示定位的文字訊息，而右側欄位則以圖形

化顯示出相對的位置，再按一次則停止工作。 

 

圖 45. Sonardyne USBL Software - Range System 
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NCU 

Port 
傳輸方向 連接儀器 

COM1 ↹ NCU 與 PC 資料傳輸 

Port2A ↹ NCU 與音鼓(Transceiver)資料及電力傳輸 

Port6A ← GPS 輸入 

Port6B ← GYRO 輸入 

Port7A ← VRU 輸入 

Port7B → 輸出已經運算過的水下目標位置到其他系統 

圖 46. 海研一號上 NCU I/O Port 設定 
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圖 47. NCU 與控制電腦的連接 

在 Ranger System 裡點選 Edit -> I/O Ports，或是點擊 進入設定

畫面(圖 48)，這步驟設定是要將系統中輸出入的訊號整合，依據 NCU 的

I/O port 實際連線(圖 46 及圖 47)，按下 Add 即可新增裝置，例如:在新增

的下拉選單中選取”NCU”加入，設定輸入埠為”COM1”，傳輸通訊協定

為”115200”，OK 完成。其他裝置也依樣新增加入，設定完成後畫面就會

像(圖 49 中的圖 A) 。 
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圖 48. I/O Ports 設定畫面 

 

上面步驟只是設定系統的輸出入裝置有哪些，下一步驟就要設定輸出

入的內容是什麼。  

首先我們要設定系統的計算原點位置，可以將音鼓視為原點(圖 49. 

Port Properties 設定畫面(音鼓及 GPS 參數修正))，或將原點平移到船隻的侧

舷邊、船中心或任何位置，開始測量各儀器相對原點的距離，然後依序設

定 Tranceiver、GPS、GYRO、VRU 等儀器參數，按下 Advanced 方塊進入該

儀器的設定畫面；以海研一號為例，若系統計算原點位置為音鼓

(Transceiver)，VRU 直接安裝在音鼓的伸縮架上方，各儀器相對位置的修

正參數如圖 50。這套系統設定定義 Starboard 是指船隻左右向(Y)，向右

為正值，Forward 指船隻前後向，向前為正值(X)，海平面高度為零，水面

上為正值(Z)。 
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圖 49. Port Properties 設定畫面(音鼓及 GPS 參數修正) 

 

 

圖 50. 海研一號 GPS、Transceiver、VRU 位置修正設定 

 

因為 USBL 系統的訊號是依賴聲波在水中傳遞，因此我們還需要輸入

作業區域的實際水中聲速值，才能得到更精準的定位，這個水中聲速值可

使用溫鹽深儀(CTD)或拋棄式溫深探針 (XBT/XSV)來取得，將水中聲速檔案

格式編輯為 ASCII Code，2 欄(深度 溫度)的檔案，便可直接輸入 Ranger 
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System，圖 51。 

 

 

圖 51. 設定水中聲速修正畫面 

 

設定好了船上固定的儀器裝置後，繼續設定水下的應答器

(Transponder/Responder)的部分，在 Ranger System 畫面上的 Tool Bar

點擊 圖示，或點選單 Edit->Transponder 進入設定畫面(圖 52 的圖

D)，在設定畫面下按”Add”，出現 New Transponder 畫面(圖 52 的圖

C)，Type 下拉選單選擇出正確型號，應答器的編碼頻率輸入等(圖 53)；我

們可以將會使用到的應答器都先設定好，Ranger System 可控制時單獨或多

隻應答器一起擊發(圖 54)。 
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圖 52. 新增應答器 WSM 設定畫面 
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圖 53. Transponder 頻率編碼設定畫面 

 

 

圖 54. DPT Transponder 擊發測試 

 

USBL 定位作業中我們需要將其他音鼓(Echo Sounder、ADCP…)關閉，

避免音鼓擊發的訊號互相干擾，在 Ranger System 下，點選功能表 Tools-

>Noise test，可以觀察 Transceiver 聽到的所有水中音訊狀況，圖 55，

如果背景雜訊過多，可能要調整應答器使用的頻率編碼，或加強 Power，提

高 S/N Ratio。點選功能表 View->Frequency Map，畫面會出現目前市面上

水下儀器常用的頻率(圖 56)，可以讓我們研判水中的背景噪音來源。 
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圖 55. Noise Mesurement 畫面 

 

 

圖 56. Frequency Map 畫面 
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六、USBL 校正流程： 

一般而言，進行 USBL 水下定位時，影響其定位精度的因素相當多，

由於其水下定位基準是研究船本身，因此船上 GPS 系統與衛星時鐘之校

正、大氣電離層影響、電子訊號傳遞延遲、水下應答器與船上收發器間方

位差所造成的相位量取誤差、水下水團特性對聲學速度的改變，以及船上

推進器的干擾等，都會對水下定位系統的精確度有所改變，因此在進行精

準海床調查前，便需對 USBL 系統進行校正。 

目前臺灣研究船的 GPS 定位已可利用廣域差分定位系統進行定位精準

度上的提高，以海研一號為例，其利用的 DGPS 定位誤差可於 20 公分以

內。在 USBL 系統的校正上，首先要利用水下應答器(transponder)對安裝

於船上的 USBL 系統收發器與姿態感測器進行校正，其中包含了水中收發

器(transceiver)與應答器間的傾斜、搖擺與艏向方位角間的校正。而目前臺

灣研究船的 USBL 系統分成固定式與活動式兩種，一種將其收發器固定在

船底，系統收發器位置固定，另一者如海研一號，每次任務前方將 USBL

收發器安裝在月池(moon pool)或船舷邊，雖較具機動性，但由於位置不固

定，在船與 USBL 系統間的校正便更為重要。 

將水下應答器下放至海床後，研究船需關閉可能產生干擾的其他聲納

系統，順時鐘與逆時鐘繞行水下應答器一圈，並需加上四條垂直通過收發

器的測線(圖 59. 進行超短基線定位系統校正時，研究船與水下應答器之

相對運動示意圖。)，船速需依照當地水深進行調整，水深較深處船速要更

緩慢，每條測線須收集到 200 個以上的有效資料點後，再搭配利用溫鹽深

儀(CTD)所取得當地深度對水速剖面的資訊，便可計算水下應答器與船上收

發器間的各項偏差參數，以進行水下定位的校正(Figure 1. 超短基線定位

系統校正前後比較)。 
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如果 USBL 的音鼓(Transceiver)及船體運動姿態儀(VRU)都是固定安裝

在船體的同一個位置上，那麼架設後只須執行一次校正程序得出修正值；

如果是這兩者會依任務拆卸裝在不同的位置或不同的船上，那就要在每次

系統安裝後重新執行校正程序的出修正值。(如圖 57. Sonardyne USBL 校正

原理 1、2)是原廠圖解說明修正的原理，不管事垂直還是水平方向，都要△

XB 及△YB 的修正量，藉由校正航行的 Transceiver 對 Transponder 的計

算，做回歸收斂計算得出各參數修正值。 

做 USBL 校正前要選擇一個平坦開闊水域，水深約 500 公尺以上，通

常會先放 CTD 或 XBT 取得當地的水中聲速剖面，(圖 63. CTD 取得水中聲速

剖面)，然後將水下應答器 DPT 套上專用黃色浮體，並在釋放裝置端繫上 80

公斤的重物(可用水泥塊或廢鐵)，EndCap 端繫上一段浮水繩(回收勾用)及

吊掛主繩；經由船上的吊車將 DPT 吊起，放入水中 15 公尺處先暫停，執行

Ranger 軟體追蹤 DPT，若能偵測到 DPT 位置後，再拉釋放勾的繩子讓 DPT

自行沉降至海床上，待 DPT 著底穩定後，就可以開始讓船繞行所規劃的航

線。 

校正的航線設定必須要重複繞行 2次且通過 Transponder 至少 4次以

上，原廠建議一條測線上至少要得到 200 個有效資料點，因此船速是根據

水深來設定，水深淺時船速相對要慢，校正時除了要穩定船速，還有天氣

也要考量，天氣不好時操船不易，船體搖擺角度大，訊號接收會不良，然

後也必須考慮傳的回轉時間、距離等，故一開始的航線規劃就非常重要。

每走過一條測線，要記的將資料關檔儲存，因此會產生許多檔案，(如圖 

60. CASIUS 進行系統校正時，圖 A航線所產生的所有資料檔，圖 B選用實

際計算的測線，圖 C實際每條測線的航跡。)，同測線可以選擇資料品質較

好的下去計算，CASIUS 計算後會產生一個校正報告，上面的參數有直接導

入 Range 軟體的功能(Export Results to USBL system)，或是手動輸入
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(圖 60. CASIUS 進行系統校正時，圖 A航線所產生的所有資料檔，圖 B選

用實際計算的測線，圖 C實際每條測線的航跡。)。 

結束校正航線時，要將 DPT 回收，用 Transceiver 呼叫 DPT 釋放重

物，等待期間可觀察 DPT 的狀態是否穩定上浮，上浮到海面後，作業人員

先用長柄鉤子勾住綁在 DPT 上的浮水繩，然後用船上吊車將 DPT 吊上甲板

進行回收。  

若是針對 AUV 的應用，由於水下並不像在海面上隨時有 GPS 的定位

結果進行水下運動的修正，因此 AUV 下水前，除了需將校正的 USBL 系統

結果輸入至 AUV 水下導航軟體外，另外要進行船上定位系統與 AUV 的水

下慣性定位系統進行整合。在 AUV 作業前，需將 AUV 安置在母船上，如

水下定位校正的船隻運動般，一同藉由順、逆時鐘繞行與垂直測線運動間

的定位測量，將船隻 GPS 與 AUV 內部的水下載具導航系統間的定位結果同

步，之後方可藉由 USBL 的定位結果，判定 AUV 在水下工作時，其內部導

航系統與實際定位結果的誤差，以確定其在水下測量點的真正位置。 

 

 
圖 57. Sonardyne USBL 校正原理 1 
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圖 58. Sonardyne USBL 校正原理 2 

 

 
圖 59. 進行超短基線定位系統校正時，研究船與水下應答器之相對運動示意圖。 



51 
 

 

圖 60. CASIUS 進行系統校正時，圖 A 航線所產生的所有資料檔，圖 B選用實際計算的測線，圖

C 實際每條測線的航跡。 

 

 

圖 61. 超短基線定位系統校正前後比較。左、右圖分為校正前、後定位結果比較。上圖為研究

船順、逆時鐘繞行與垂直交叉通過水下應答器後，研究船與水下應答器的相對定位結果，下圖

為定位資料點在空間上的散佈狀況。校正後的系統定位成果方才集中在水下應答器在海床上的

投放位置。 
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圖 62. 圖 A、CASUIS 校正報告，圖 B、圖 C、Range->I/O Ports->Tranceiver 修正值輸入處 

 

 

圖 63. CTD 取得水中聲速剖面 
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圖 64. 水中應答器 DPT 配置示意圖 
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七、USBL 應用實例： 

臺灣目前高解析度的精準海床調查大致可分成底拖式系統、海床採樣

與觀測、水下載具，如遙控式水下無人載具(Remotely Operated Vehicle, 

ROV)與 AUV 等，皆是利用超短基線水下定位系統取得準確的水下定位資

訊。以下將以底拖式攝影系統、岩心採樣器與 AUV 三項調查為例，介紹臺

灣研究船進行高解析度的精準海床調查的應用。 

 底拖式攝影系統 

底拖式攝影系統(TowCam)是高解析度海床調查的極佳例子之一，我國

TowCam 系統(圖 65. 底拖式攝影系統安裝於水下載具上。前後可見光源，

攝影機安裝在中間下方。其他空間可安裝其他水下測量儀器。(本系統所屬

於經濟部地質調查所))是由林曉武教授進行地質調查所計畫時引進美國木

洞研究所(WHIO)開發的底拖式系統，主要是將水下攝影機、CTD、水下光

源、USBL 四個主系統，搭配所需求的探針，安裝在繫纜水下載具上，系統

採用抗高壓低溫材質，可用拖曳方式取得影像以及 CTD 與探針量測到的數

據，是一種在搭配 USBL 系統後，可取得深海高解析度海床影像的調查工

具 (圖 66. TomCam 影像。可觀察到深海中泥火山系統所導致的海床底質

改變狀況特徵。黃色虛線以下出現疑似碳酸岩礁與硬泥塊所造成的突起特

徵，也可見海膽(黑箭)、海百合(紅箭)等深海生物。)。此系統運作成本相

較於 ROV 來的便宜許多，在大部分的臺灣研究船上也都能運作，是所謂實

用的「窮人深海攝影機」。 

早期，此系統的攝影位置是利用下放深度與母船定位值進行推算，誤

差範圍可達百公尺以上，有時在影像中記錄到的目標物，如冷泉系統(cold 

seep system)的冒氣裂縫或是泥火山口等，其特徵可能僅在數公尺間，也因

為定位的誤差而難以進行後續的取樣工作，目前經過 USBL 系統的應用，

已可精確求出影像上目標特徵的準確位置，對於生物棲地研究、冷泉系統
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分布以及海床上天然氣水合物滲漏處的探勘都有極大之幫助。 

 岩心採樣 

傳統的岩心採樣位置，大多僅利用船上 GPS 定位結果而定，然而岩心

在下放至海床的過程中，受限於船上的動態定位能力，風浪產生的漂移、

下放岩心纜繩受海流影響而產生的偏移等，都會使得岩心下放至海床時的

實際採樣點與船隻定位結果，產生數十公尺的偏移，在水深較深處，甚至

可能導致百公尺等級的誤差。雖然在一般的海洋研究中，這樣的定位精度

並不影響岩心的解釋，但在進行特殊構造的採樣時，其構造規模也可能僅

有數公尺，若無法進行精準取樣，便無法取得有用之樣品。 

因此藉由 USBL 定位系統與岩心採樣器的搭配(圖 67. USBL 與岩心採

樣器進行搭配之施放作業。將應答器固定於重力岩心採樣器上方 50 公尺的

鋼纜上，於下放纜繩時就可即時進行定位，等至到達目標點時在進行採

樣，便可收集精確之採樣點。)，將應答器固定於岩心採樣器上方的鋼纜位

置，如此在下放纜繩時，便可隨時掌握採樣器位置並進行船隻運動的微

調，待將採樣器位置控制在目標物正上方不遠處後，便能精確的取得深海

標的樣品。而搭配水下攝影系統的影像資料，對於岩心標本採集位置的精

準度與周邊環境的評估資訊也有大幅的提升。台灣也曾在海研一號及五號

上完成這樣高解析度的精準海床調查，並將其應用在深海天然氣水合物與

泥火山系統的研究當中。 

 自主式水下無人載具 

AUV 是目前國際上進行深海研究的最新利器，它由電池提供動力，與

母船間不需電纜連結，其水下調查活動乃是由下水前輸入的程式來操控，

並搭配感測裝置，自動在其探測路線上調整，必要時也可利用電波或聲波

進行操控，遇緊急狀況時，也會自動浮上水面並傳送位置座標給母船，是

一個具有感測、判斷與行動自主的人工智慧載具。其調查路線可極貼近海
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床(數十公尺)，並利用其搭載的多音束測深儀、海床底質聲納剖面儀取得

極高解析度(0.5 公尺解析度)的海床與淺部地層影像。 

臺灣也分別於 2012 與 2013 年，和德國 MARUM(2012 年)與美國的

MBARI(2013 年)兩個海洋研究單位合作，在臺灣西南海域天然氣水合物賦

存區，利用海研五號進行 AUV 的高解析度海床調查任務。以 MBARI 的

Mapping AUV 為例，在水下定位部分，該 AUV 運用其內部慣性導航定位系

統與海研五號上的水下定位系統相結合，透過量測二者訊號間的訊號走時

與相位差，取得 AUV 與海研五號間的相對方位與距離，再搭配母船上的差

分式定位系統，以及 AUV 內的都卜勒流速儀量取的速度資料，進行水下調

查路線的運動速度與路線修正。這樣複雜的操作是因為，AUV 的調查主要

是靠程式依據慣性導航定位的結果進行運動，而慣性系統的導航誤差會隨

時間而不斷累增，進而影響其調查成果，因此便需要靠都卜勒流速儀取得

AUV 對水的相對速度變化，以及母船的 USBL 定位結果來進行測量點的位

置校正，方能配合 AUV 內姿態感應器(motion sensor)所收集的姿態資料，

進行多音束水深量測時的疊合測試（patch test），以修正 AUV 的姿態誤

差，之後才可獲得高解析度的海床地貌資料。而這些高解析度的海床影

像，也對於掌握泥火山噴口噴發出的天然氣異常特徵，以及解釋深海中地

化異常訊號的變化起了很大的幫助。 



57 
 

 

圖 65. 底拖式攝影系統安裝於水下載具上。前後可見光源，攝影機安裝在中間下方。其他空間

可安裝其他水下測量儀器。(本系統所屬於經濟部地質調查所) 

 
圖 66. TomCam 影像。可觀察到深海中泥火山系統所導致的海床底質改變狀況特徵。黃色虛線

以下出現疑似碳酸岩礁與硬泥塊所造成的突起特徵，也可見海膽(黑箭)、海百合(紅箭)等深海生
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物。 

 

 

圖 67. USBL 與岩心採樣器進行搭配之施放作業。將應答器固定於重力岩心採樣器上方 50 公尺

的鋼纜上，於下放纜繩時就可即時進行定位，等至到達目標點時在進行採樣，便可收集精確之

採樣點。 
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